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The information contained in this guide is intended to provide an overview of the GASWorkS software by
demonstrating a portion of its extensive feature set. Although the GASWorkS feature set is not fully
demonstrated, we hope that the features that are used during the exercises will provide a good appreciation
for how GASWorkS may be able to satisfy your network modeling needs.
The instructions in this guide assume that the User has some knowledge of working with the Windows
operating environment and Windows based applications. The example in this guide is for a simple
distribution style piping system, however please remember that the tasks used to create, solve, and edit this
model are applicable to any type of gas piping system.
The remainder of this guide will step you through the installation of GASWorkS, and the creation and
manipulation of a simple example model. Inserted throughout the text are notes which provide additional
information about the software. The example exercise is a bit long, however please be patient and persistent
in working through it - completion of the example will provide a valuable lesson on how to use the software
to efficiently meet your modeling needs.

Getting Help - Contact Us
Hours - Our normal work hours are 8:00 A.M. to 5:00 P.M. Mountain Time, Monday through Friday.
However if you have a problem, please try at any time, we may be in.
By Telephone - (719) 578-9391
By Email - help@b3pe.com
By Website - www.b3pe.com

Hardware/Software Requirements
GASWorkS will operate on any personal computer (PC) configured to run the Windows™ 8 thru Windows™
11. The Demonstration version of the GASWorkS software will require a minimum of 31 MB of free hard
disk space when installed.

Installing GASWorkS
An appropriate version of Windows must be running in order to install GASWorkS. If it is not, start
Windows now.
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• On Windows Vista and newer machines, you will need to be logged on as the Full
Administrator or use the “Run as administrator” option when executing the installation file.
• In the following steps it is assumed that the compressed folder (“zip” file) containing the
demonstration software has already been downloaded to your machine. If it has not been
downloaded, go to our website (www.b3pe.com) to download it before continuing.

! Find the location where the download folder is saved on your machine. Open the folder using Windows
File Explorer.
! Double-click on the executable demo file contained in the folder. If a Windows Security warning appears,
allow your machine to install the file.
! After the setup program has been started, several screens will appear during the installation process. Read
the contents of each screen carefully and respond appropriately.
Note...

On the License Agreement screen, read the terms of the License carefully and select the “Agree
to” option. If you do not wish to accept the License Agreement, you will not be able to continue
with the installation process.

! A message will be displayed when the installation process is complete. The message will indicate whether
the installation was successful or whether it failed. Select the appropriate option to clear the message.

Starting GASWorkS
Note...

• An appropriate version of Windows must be running before GASWorkS may be executed. If
Windows is not running, begin its execution now.
• On Windows Vista and newer machines, you will need to be logged on as the Full
Administrator or use the “Run as administrator” option the first time you execute the GASWorkS
software.

! From the Windows Desktop, click the GASWorkS 10.0 shortcut icon.
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! The GASWorkS software will be started.
! After the software has been loaded into memory, the GASWorkS
Welcome screen will be displayed. Click the Continue command button.
! The Demonstration Notes screen will be displayed. Read the contents
carefully and select any desired options, then click the Continue
command button.

Example
Various example files are included when GASWorkS is installed on the hard disk. These files are installed
in the “files” subdirectory of the GASWorkS root directory. The example files contain a variety of system
types. You can view, manipulate, and solve these example files - or use the instructions provided in the
following sections to create, edit, solve, and report your own example model.
In this example, a model will be developed for a simple piping system representing a light industrial park
using generic loads. Once the model is built and solved, a new connection and demand will be added to the
system. The new load will exceed the capacity of the system. Changes will be made to the system to allow
the addition of the load. During the course of the example, you will learn how to create a new model using
various coordinate entry methods, solve a model, display graphic results, color code based on result values,
edit pipe and node data, tap an existing pipe, and use the report features.
Note...

• GASWorkS has an automatic save feature which can be turned “On” or “Off” depending on the
User’s preference. As initially installed, the option is turned “On”. To change this preference
option, select the Settings item from the Preferences submenu list of the File menu list.
• This example assumes that the settings, options, and default data values are set to the original
installed values. If they have been changed, some of the example steps may not behave or appear
as described.

Creating A New Model
! If a model is already open, close it now by selecting the Close item from the File menu list.
! The first step in creating a model is to open a new set of model files. To open a new model...
! From the File menu list, select the New item.
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! The Model Selection screen will be displayed. Enter the desired name by typing it in the
Model Name data field. For example, type MyDemo in the data field. When an appropriate
model name has been entered, click the Continue command button to proceed.
! The Graphic Data Interface (GDI) Window will be displayed.
Note...

If the GDI Window is not automatically displayed, select the View/Edit item from the Graphics
menu list to display the GDI Window.

! Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls
Toolbar.
Note...

• To assist in building a model using the drawing method, GASWorkS provides two “snap”
methods which cause a pipe end to be snapped to an existing node. The first snap mode is
referred to as “auto-snap”. This is the method we have been using by holding down the Shift key
while left-clicking the mouse when prompted for a node location.
• The second method is referred to as Feature Snap, this method snaps to an existing feature
(node) found within a certain distance of an entered location. To use this method, click the
Feature Snap icon from the lower-left corner of the GDI Window until the icon’s background is
darkened. When this method is turned “On”, a circle will be displayed around the mouse
crosshairs. This circle represents the snap distance (a feature falling within the snap distance will
be connected to).

! Ensure that the Feature Snap is turned “On”. Click on the Feature Snap icon from the lower-left
corner of the GDI Window until the icon’s background is darkened. The Feature Snap will
automatically force (snap) the new coordinate selection to an existing feature within the Snap
Target of the selected location.

Setting The Default Data Values
When creating a new model or adding new features to an existing model, the data values for the new features
are set using the current default data values. If similar models are being created, these values only need to
be set once. However, if models that are not similar are being created, the values will need to be
appropriately set when changing model types.
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An alternative to using the Default Data Values to populate values for newly entered features, the data from
the last similar feature in the model can be used to populate the values for a new feature. To use this method,
select the Use Last Record For Default Values option in the Preference Settings.
Note...

In this document, two values are listed where a data value is given. The first value represents the
value in English/US dimensional units. The second value (enclosed in brackets [ ]) represents the
value in Metric dimensional units. Use the appropriate values.

To set the default data values...
! From the Utilities menu list, select the Set Defaults item. The Default Data Values screen will be
displayed.
! On the Dimensional Units data tab, set the following values:
Coordinates = Feet [Metres]
Customer Load = Cfh [M3h]
Diameter = Inches [Millimetre]
Efficiency = Decimal
Elevation = Feet [Metres]
Heating Value = Btu/cf [MJoules/m3]
Length = Feet [Metres]
Node Load = Mcfh [M3h]
Pipe Flow Rate = Mcfh [M3h]
Pressure = Psi [mBar]
Temperature = Fahrenheit [Celsius]
Velocity = Feet/sec [Metres/sec]
Viscosity = Lbm/Ft-sec [Centipoise]
! On the Hydraulic Data tab, set the following values:
Pipe Size/Type = 2P Inches [63P-11 Millimetre]
Pipe Equation = IGT-Improved
Pipe Efficiency = 0.95 Decimal
Allow Pipe Sizing = Unselect
Node Pressure = 0 Psi [0 mBar]
Value Is Unknown = Select
Node Base Load = -10 Mcfh [-280 M3h]
Value Is Unknown = Unselect
Node Elevation = 0 Feet [0 Metres]
Node Temperature = 60 Fahrenheit [15.6 Celsius] Value Is Unknown = Unselect
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! On the Gas Properties data tab, set the following values:
Specific Gravity = 0.6
Viscosity = 0.000007 Lbm/Ft-sec [0.0104 Centipoise]
Heating Value = 1000 Btu/cf [37.2 MJoules/m3]
Specific Heat Ratio = 1.3
Values Are Unknown = Unselect
! When all the values have been entered, click the Close command button to close the screen and
save the settings.

Set The Preference Settings
! From the File menu list, in the Preferences submenu,
select the Settings item. The Preference Settings screen will
be displayed.
Use Last Record For Default Values = Unselect
! Click the Close command button to save the changes and
close the screen.

Graphic Settings
When a new customer, node, or pipe feature is added to the model, the data for the new feature can
automatically be displayed in the Data Panel after the addition. This option allows the User to make desired
changes to the added feature’s data during the entry command. The Allow Data Entry During New Feature
Entry option, by default, will be turned “On” for easy editing while adding the new features.

Using The Graphic Data Interface (GDI) Window
When using GASWorkS, much of your time will be spent working within the GDI Window, so let’s take
some time to describe its various features. A set of GDI Toolbar Icons are displayed along the left side of
the GDI Window. When the mouse pointer is passed over a GDI Toolbar Icon, the toolbar will be expanded
exposing the GDI Command Icons. The GDI Command Icons are used to execute many of the GDI
Commands and are grouped by functionality.
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In the GDI Window, a GDI Command is executed either by clicking the appropriate GDI Icon,
by selecting a command from the GDI Command List, or by typing the command name or
abbreviation on the GDI Command Line. In this example, we will use the GDI Icon method of
execution. If a GDI Command is accidentally selected, it may be canceled by clicking the Cancel
icon.
The GDI Command List icon is located in the upper-right corner of the GDI Window. When
selected, the GDI Command List will be displayed in the lower-right corner of the GDI Window.
The GDI Command Line is located at the bottom of the GDI Window below where the mouse
coordinate values are displayed.
When a feature is selected or a new feature is added, the associated data will be displayed in the upper-right
side of the GDI Window in the Data Panel. If changes are made to the associated feature, click the Apply
Data Values command button to save and apply those changes.
The GDI Window will display differently on different monitors. Let’s resize it now so that it fits
nicely on your monitor. Click the Maximize GDI Window icon from the GDI Window Controls
Toolbar to fit the window to your monitor.
Note...

The GDI Window can also be manually sized by dragging the sides or corners of the window with
the mouse. To save the current window size as the default for future models, select the Settings
item from the Graphics menu list. The Graphic Settings screen will be displayed. Click the Save
As Default command button, click the OK command button to save changes, then click the Close
command button to close the screen.

The main portion of the GDI Window is comprised of the GDI Display. The GDI Display is the portion of
the screen where the model image (GDI Image) is displayed. The Scroll icon is located in the lower-left
corner of the GDI Window. The view may be moved right or left and up or down by selecting one of the
arrow symbols on the icon. The Zoom To Fit, Zoom In, and Zoom Out icons are located next to the Scroll
icon. When a GDI Command requires keyboard input, a prompt will appear just above the GDI Display.
Note...

GASWorkS provides several ways to enter a node’s location. These include - specifying an X-Y
coordinate pair, specifying a relative distance and angle, and drawing the segment with the
mouse. We will use each of these methods when constructing the example model. If your
Windows environment is set to use a comma “,” as the decimal separator, use a space to separate
the coordinate values.
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Building The Model
1) Add The First Pipe Using The Coordinate Method Of Entry
! Click the Add 2-Point Pipe icon from the Graphic Construction Commands Toolbar.
! For the From Node Location, type 1000,1000 on the GDI Prompt Line and press the
Enter key.
! The Node Data will be displayed in the Data Panel. In the Hydraulic Data Items section, set the
following values:
Name = SUPPLY
Pressure = 20 [2000]
Pressure Units = Psi [mBar]
Pressure Known = Yes
Note - The Base Load Known should automatically set to “No”
! The remaining values are acceptable. Click the Apply Data Values command button located at the
bottom of the Data Panel to continue.
Note...

Note...

The setting of the “Known” items indicate whether the associated value is known or unknown.
When a “Known” item is set to “No”, the value is unknown and will be calculated during the
Solution routine. At this node we indicated that the pressure was known (set to “Yes”), and that
the base load was unknown (set to “No”). Generally, either the pressure value or the load value
must be “Known” at each node but not both. At demand nodes the pressure is generally set as
“Unknown” and the load is set as “Known”. A negative load value indicates that gas is leaving
the system.

Depending on the Zoom Scale, a node symbol may appear at the new node’s location. Whether
a node symbol is displayed or not, a “stretch” line should be displayed from the entered node
location. We will zoom in later to make the view easier to see.
! For the To Node Location, type 1500,1000 [1150,1000] on the GDI Prompt Line and press the
Enter key.
! The Node Data will be displayed in the Data Panel. The displayed values are acceptable. Either
click the Continue command button, or right-click the mouse to continue.
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! The Pipe Data will be displayed in the Data Panel. In the Hydraulic Data Items section, set the
following values:
Size/Type Code = 4P [125PE-S11]
Diameter Units = Inches [Millimetre]
! Click the Apply Data Values command button to continue.
! A pipe line (blue line) will be displayed at the entered location.
Note...

The Size/Type Code list contains various predefined Size/Type Codes. Each code represents an
entry in the Pipe Property Table. GASWorkS uses Property Tables to store redundant data items,
such as Inside Diameter values. Property Tables are provided for pipe, fitting, regulator, valve,
compressor, and well data values. The User may add to or revise the data contained in any of the
Property Tables.

2) Add The Second Pipe Using The Relative Distance & Angle Method
! Right-click the mouse while the mouse pointer is in the GDI Display. The last GDI Command will be reexecuted.
! For the From Node Location, right-click the mouse to accept the default From Node coordinates
(1500,1000 [1150,1000]).
Note...

GASWorkS remembers the coordinates of the last node that was entered. When a default
coordinate pair is displayed, either press the Enter key or right-click the mouse to accept the
coordinates.
! For the To Node Location, type @500<180 [@150<180] on the GDI Prompt Line and press the
Enter key.

Note...

The “@” symbol tells GASWorkS that a relative distance and angle will be used to locate the
node. The node location is calculated relative to the From Node Location. Angles are measured
clockwise from the 12 o’clock position (top of display) - zero (0) represents north.
! The Node Data will be displayed in the Data Panel. The displayed values are acceptable. Either
click the Continue command button, or right-click the mouse to continue.
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Notice that the Node Data did not display for the From Node, but it did display for the To Node.
That is because the data is only displayed when a new feature is entered. The From Node was
previously entered, so the data was not displayed.
! The Pipe Data will be displayed in the Data Panel. In the Hydraulic Data Items section, set the
following values:
Size/Type Code = 2P [125PE-S11]
! Click the Apply Data Values command button to continue.

! To make the pipes we just entered easier to see, let’s zoom in on the GDI Display. Click the
Zoom To Fit icon from the lower-left corner of the GDI Window to cause the GDI Image to be
zoomed to fit into the GDI Display.

3) Add The Third Pipe By Using The Drawing Entry Method
! Select the Add 2-Point Pipe item from the GDI Command List.
! For the From Node Location, move the mouse crosshairs and circle so that Node 15 is
within the circle, and left-click the mouse to indicate the node’s location.
Note...

• If the Node Data is displayed in the Data Panel, it indicates that the location for the node was
not properly selected. To reselect the From Node Location, click the Cancel icon and re-execute
the Add 2-Point Pipe command.
! For the To Node Location, move the mouse crosshairs to a location below Node SUPPLY and to
the left of Node 15 (similar to Node 20 in Figure 1), and left-click the mouse to indicate the node’s
location.
! The Node Data will be displayed in the Data Panel. The displayed values are acceptable. Either
click the Continue command button, or right-click the mouse to continue.
! The Pipe Data will be displayed in the Data Panel. The displayed values are acceptable. Either
click the Continue command button, or right-click the mouse to continue.

After entering this pipe, the model should look similar to Figure 1.
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Figure 1

4) Add The Fourth (Last) Pipe
! Right-click the mouse while the mouse pointer is in the GDI Display to re-execute the last GDI Command,
Add 2-Point Pipe command.
! For the From Node Location, right-click the mouse to accept the default coordinates.
! For the To Node Location, move the mouse crosshairs and circle so that Node SUPPLY is within
the circle, and left-click the mouse to indicate the node’s location.
Note...

If the Node Data is displayed in the Data Panel, it indicates that the location for the node was not
properly selected. To reselect the location, click the Cancel icon and reselect the Add 2-Point
Pipe icon.
! The Pipe Data will be displayed in the Data Panel. The displayed values are acceptable. Either
click the Continue command button, or right-click the mouse to continue.

After entering the last pipe, the model should look similar to Figure 2.
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Figure 2

Solve The Model
Now that the model has been created, the unknown pressure and flow values may be calculated by “solving”
the model. To solve the model...
! Click the Solve icon from the lower-right corner of the GDI Window. The Solution
Data screen will be displayed. On the Other Settings data tab, set the following values:
Base Pressure = 14.73 Psi [1016 mBar]
Base Temperature = 60 Fahrenheit [15.6 Celsius]
! For this example, the remaining default solution parameters are acceptable. Click the Solve
command button to proceed with the solution.
! While the solution is performed, the Solution Log will be displayed. The Solution Log displays
the solution activity and informs the User when the solution is complete.
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The Solution Log displays the progress of the Solution routine. During a normal solution the node
errors should start relatively large and get smaller as the Solution progresses, until the node error
is less than the specified convergence tolerance. The last line of the Solution Log should indicate
“Solution Complete”. If the Solution is not complete, recheck the model creation steps, correct
any errors you encounter, then re-solve the model.
! Upon completion of the solution, click the Close command button to close the Solution Log and
return to the GDI Window.

! Notice that the Solve icon has changed. The scale is now blue and balanced indicating that the
model is balanced.

View The Analysis Results
Now let’s review the analysis results. In addition to its various Report routines, GASWorkS also provides
several graphical methods for viewing both the model data and the analysis results. We will look at the
Report routines later, for now let’s use some of the graphical methods to view the analysis results.
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Notice that the flow arrows are now displayed, indicating the direction of the pipe flow. Note If the flow arrows aren’t displayed, click the Display Flow Arrows icon from the Display Controls
Toolbar.

Let’s display the pressure values for the nodes...
! Click the Text Display Settings icon from the Display Controls Toolbar. The Text
Display Settings screen will be displayed.
! On the Node Items data tab, set the following items:
Display Node Text Items = Select
Transparent Font = Unselect
Node Pressure = Select
! Click the Apply command button to apply the changes to the display.
The pressure values and flow directions should be similar to those shown in Figure 3.

Figure 3
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• The displayed pressure values represent the estimated pressure for each node point. As a result
of “drawing” in the third and fourth pipe segments, each example model is created slightly
different. The different pipe lengths will cause different pipe resistance and the different pipe
resistance will cause different pressure drop and pressure values. A large difference indicates that
an error has occurred during the creation of the model. If this is the case, you might want to
retrace the creation steps to identify the problem.
• The analysis results for an individual pipe or node can be viewed and printed using the Edit
Node Data and Edit Pipe Data commands, or by simply clicking the mouse on the desired
feature.

Tap A Pipe
To simulate a new connection to the system, let’s add a new node (a pipe tap) to the pipe segment between
Node 15 and Node 20. To make a tap...
! Click the Tap Pipe icon from the Graphic Edit Commands Toolbar.
! For the Select Pipe To Tap, move the mouse pointer to the pipe between Node
15 and Node 20 and left-click the mouse.
! For the Tap Location, move the mouse crosshairs midway along the pipe segment between
Node 15 and Node 20 and left-click the mouse.
! The Node Data will be displayed in the Data Panel. In the Hydraulic Data Items section,
set the following values:
Name = NEWTAP
Base Load = -40 [-2500]
Load Units = Mcfh [M3h]
! The remaining data values are acceptable. Click the Apply Data Values command button
to continue.
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• The load for the Node NEWTAP was entered as a negative value. Remember that a negative
value indicates a load leaving the system (a demand).
• Because a change has been made to the model, the previously computed pressure and
flow values are no longer valid. To see the effect of the new load on the system, we
will need to re-solve the model. Notice that the Solve icon has changed - the scale is
now unbalanced indicating that the model needs to be solved.

! Re-solve the model by clicking the Quick Solve icon from the lower-right corner of the GDI
Window. The pressure value for Node NEWTAP will be calculated and displayed on the model.
In Figure 4, notice that some of the pressure values are negative (less than zero). This indicates
that the system has “run-out-of-gas”. In other words, the increased demand caused by the new load, is greater
then the system’s capacity.

Figure 4

To correct this issue, normally you might increase the size of the pipes with the highest pressure drop. Let’s
use the color coding features to try to find the pipes with the highest pressure drop.
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Color Coding Pipes & Nodes
GASWorkS provides several routines for color coding pipes and nodes based on their data values. Features
may be colored based on the results of a query. For example, all of the nodes where the pressure value was
less than a specific pressure value could be colored red. Features may also be colored based on a range of
values. The range values and colors may be set by the User or automatically set by GASWorkS. Let’s use
one of the automatic range methods to color code the pipes.

To determine which pipes have the highest pressure drop, we will color code the pipes based on the their
pressure drop values.
! Click the Color Display Settings icon from the Display Controls Toolbar. The Color
Display Settings screen will be displayed. On the Range Colors data tab, set the following
values:
Item = Pipe Pressure Drop
Units = Psi [mBar]
! Click the Calculate command button to automatically set the range values. Values will be
displayed in the From and To data fields.
! Click the Apply Range Colors command button. The colors of the displayed pipes will be updated
to reflect the range color values as seen in Figure 5.

Figure 5
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! As a reminder of the range color values, click the Display Color Legend icon from the Display
Controls Toolbar. The Color Legend will be displayed using the calculated color and value
ranges.
! You may move the Color Legend to a convenient location. The Color Legend can
be resized by dragging its sides or corners with the mouse. To turn “Off” the display
of the Color Legend, click the Display Color Legend icon from the Display Controls
Toolbar again.
Note...

In this case, the pipes with the highest pressure drop are colored black.
The segments between Node 10 and Node 15 and between Node SUPPLY
and Node 20 might both be colored black or one or the other might only
be colored black. The results vary because of the varied pipe lengths
resulting from the drawn pipe segments.

Let’s try to fix the pressure problem at Node NEWTAP by changing the size of the pipe between Node
SUPPLY and Node 20.

Edit Data
During some of the previous steps, we used the GDI edit features to change the data associated with the new
nodes and pipes we entered. Now let’s use the GDI’s edit features to increase the size of the pipe between
Node SUPPLY and Node 20.
! Select the pipe segment between Node SUPPLY and Node 20 by moving the mouse pointer to
the pipe segment and left-click the mouse.
! The Pipe Data will be displayed in the Data Panel. In the Hydraulic Data Items section,
set the following values:
Size/Type Code = 4P [125PE-S11]
Diameter Units = Inches [Millimetre]
! Click the Apply Data Values command button to save the changes.

! Click the Solve icon from the lower-right corner fo the GDI Window. The Solution
Data screen will be displayed.
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! On the Solution Data tab, set the following values:
Update Color Coding = Select
! Click the Solve command button. The Solution Log will be displayed. Review the results, then
click the Close command button to close the log.
We can see that all of the node pressures are now positive. If the current values are adequate, we can
conclude that the change that we made fixed the problem, or we can change additional pipe sizes and re-solve
the model to see the results.
Note...

Notice that the pipe colors were updated to reflect the new pressure drop values. By selecting the
Update Color Coding option, the last range color values were used to update the GDI feature
colors after the solution was complete.

! We can reset the feature colors (pipe colors) back to their original color values. To do this, on the GDI
Command Line, type RESET and press the enter key. The feature colors (pipe colors) will now be displayed
in the original colors.

Working With The Data Reports
To view the Node Data Report...
! From the Report menu list, select the Node Data item. The Node Data Report will be displayed.
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Sort the results in the Node Data Report from the lowest to the highest pressure value. To do this...
! Click the Make Selection Set icon. The Query Specifications screen will be displayed.
Set the following values:
Where = Node Pressure
Is = Min
To = 10 [2000]
! Click the Perform Query command button to create the selection set, then click the OK command
button to clear the message. Click the Close command button on the Query Specifications screen.
The pressure node values should now be listed from the lowest to highest value.

Note...

• The contents of the reports can be manipulated by creating “selection sets” based on User
specified selection criteria. The previous few steps created a sorted selection set which found the
ten (10) lowest pressure node values. In this case there were only five nodes in the model, so all
records were included in the selection set, ranking them from the lowest to the highest
value. Successive selection sets can be created.
• A selection set can be “cleared” by choosing the Reset Selection Set icon.

! Click the Close command button to close the Node Data Report.
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! From the Report menu list, select the Pipe Data item. The Pipe Data Report will be displayed. Use the
horizontal scroll bar to view items displayed on the right side of the report. As you scroll, you will see the
various items reported for the pipe features including the calculated Flow Rate, Pressure Drop, Velocity, and
Volume values for each segment. When you are done browsing the report, click the Close command button.
Note...

• This example barely touched on the many features associated with the various reports. The
reports allow data editing directly from the report screen by simply clicking on the appropriate
data cell. The User may control the contents of the report by expanding and collapsing columns,
and by creating query based selection sets. There are also several routines provided for sorting
and browsing through the report contents.
• Because of the amount of data contained in the reports, the report width will generally be
greater than a printed page width. When using the Print routine, a message will be displayed
stating that the report width is greater than the page width. An option will be given to cancel the
Print routine or continue. Generally, you will want to select the continue option. If the Print
routine is continued, the report will be printed on multiple pages.
• To better fit the report on the printed page: Try reducing the number of columns by
using the Set Columns routine to specify which columns to display and print. When
the Set Columns icon is clicked, the Columns screen will be displayed. The selected
column names represent the columns that are currently displayed. Unselect some of
the columns. Use a proportional font like “Arial Narrow”. Use a font size of 9 points or smaller.
And set the printer orientation to “Landscape”.

What To Do Next
These last few steps demonstrate the most powerful use of GASWorkS - the ability to study the affect of
system modifications before they are implemented. By analysis of these effects using the model, changes
which might adversely affect the system, may be identified before they become a real problem. Furthermore,
solutions to counter or fix the results of a negative change, can be easily tested in the model, avoiding
installation of incorrectly sized facilities in the field.
There are several prebuilt example models distributed with the software. Refer to the Help Guide located in
the Help menu list for descriptions and instructions for viewing the various example models. These prebuilt
examples include applications using regulators, hydraulic valves, fittings, compressors, and wells, and
demonstrate many of the features associated with the software.
This simple example provided a brief overview of the basic routines found in the GASWorkS software. There
are many routines that were not used in the example - the Import and Export routines, attribute valves,
tracing, data checking, use of the Pipe Sizing routine, and use of the customer data features were all absent
from the demonstration example. Perhaps you may wish to explore some of these features on your own.
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Information about these features can be found in the User’s Manual or the Help Guide. These documents may
be downloaded from the Documents section of our website, www.b3pe.com.
When you are done exploring the software, select the Exit GASWorkS item from the File menu list to close
the program. A message may be displayed asking whether to save or discard the changes made to the model select the appropriate option. If you choose not to save the changes, they will be ignored.

Uninstalling GASWorkS
If after using the GASWorkS software you wish to remove it, select the Uninstall GASWorkS 10.0 item from
the GASWorkS Programs List.
! After the Uninstall Program has been started, read the contents of each screen carefully and respond
appropriately.
Note...

If the Uninstall Program asks to remove any shared system files, click the No command button.

! A message will be displayed when the Uninstall routine is complete. The message will indicate whether
the routine was successful or whether it failed. Select the appropriate option to clear the message.
Note...

! On some machines, the Uninstall routine will not be able to remove any directory or file that
has been created after the initial installation.
! Some of the files and/or folders created by GASWorkS after the installation may include files
in the initialization directory (ini), files in the default model file directory (files), and/or files in
the application directory (app).
! To remove these files and/or folders, use Windows File Explorer to find and delete the
remaining files and folders. An example of the path for the initialization folder is shown below.
The other folders have similar path locations.
• 32-bit machines - C:\Program Files\GASWorkS 10\ini
• 64-bit machines - C:\Program Files (x86)\GASWorkS 10\ini
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